Coefficient of Determination ($r^2$). A coefficient of 1 indicates that the line fits the data points perfectly. General equation for a straight line:

$$Y = mX + b$$

Where:
- $Y$ = Y axis data point
- $X$ = X axis data point
- $m$ = slope of the line
- $b$ = Y axis intercept point

One other Calculation Method option is DIN compliant linear regression. This calculates the linear regression based on DIN 38402 requirements, where only the first and last standard replicates are used.

**Other Fields**

Enter the desired Sparge time and Acid Addition values, if required for the analysis type. The other fields on the Conditions Tab default to the measurement parameters, accessed by the Options/Measurement Parameters command (see p.112 for more information.). Changes made here override the Measurement Parameter entries.

> **Note:** When using the Calibration Curve dialog box for inserting standards into the Sample Table, do not select Range and Injection Volume values. Instead, fill out the standard concentrations in the Data tab, and the program will select an appropriate Range and Injection Volume for you. These values can be changed if desired.

---

**Curve Tab**

The Curve Tab shows a graph of the calibration curve. For your reference, the Slope, Intercept, and $r^2$ values are given. (See the section on the Conditions Tab, above, for more information on these values.) Note that if point-to-point curve fit was chosen, no $r^2$ value is calculated. The graph can be customized; for more information, see p. 142.

**Data Tab**

The Data Tab shows calibration information. The items available in this tab will vary, depending on
whether SSM or ASI is selected; see Sample Table, p. 133, for more information. The left half of the table gives the standard information. The right half shows Mean area count, Standard Deviation and Coefficient of Variation.

The formulae for these calculations are shown below.

\[
\bar{X} = \frac{\sum_{i=1}^{n} X_i}{n}
\]

Mean area count:

\[
S = \sqrt{\frac{\sum_{i=1}^{n} (X_i - \bar{X})^2}{n-1}}
\]

Standard deviation:

\[
V = \frac{S}{\bar{X}} \times 100\%
\]

Coefficient of variation:

Also, note that standard data can be excluded from calculation. Click in the row, then press the EXCLUDE button. An “X” appears in the EXCLUDE column of the row, indicating that the data from the row is not part of the calculations. (In the Curve tab, the excluded data point(s) appear black.) To add the excluded data point(s) back into the calibration, select the EXCLUDE button again, after clicking in the line of the table to be re-added. Note that the Recalculate command must be executed to reflect these changes in the calibration curve.

A selected calibration point can be deleted by clicking in a row and choosing DELETE. Once a calibration point has been deleted, it can be re-added by opening the Sample Table that contained the standard analysis and using the Recalculate command (Edit/Recalculate).

The DELETE ALL button deletes all calibration points from the table.

When using the Edit/Insert Standard command, refer to the section on the Sample Table, p. 133, to fill in the column information.

\begin{itemize}
\item \textbf{Note:} As opposed to the instrument control program, standards and samples can be placed in any ASI tray position with PC Control. Standards do not have to be in the S1-S8 positions.
\end{itemize}

Return to the Conditions Tab to see the Range and Injection Volume selected automatically by the program. Then click OK to enter the standard information into the Sample Table.

Note that the Calibration items can be printed on a report (see p. 57 for details).

\begin{itemize}
\item \textbf{Note:} If the current calibration curve is edited, the changes do not take effect until the standard analysis is completed.
\end{itemize}
Calibration Curve File List

Select this command to view a list of all Calibration curves. To view or edit a calibration curve, select the file name, then OPEN. To create a new Calibration Curve (.cal) file, select New. See p. 72 for a complete description of the Calibration Curve file.

The new or edited calibration curve Data tab information, when saved, can be inserted into the Sample Table with the Insert Standard command (see Insert Sample p. 68). The .cal file can also be specified in a Method for sample or control calculations (see Method, p. 83).

For information about the Network button, see Network, p. 51.

Injections

Highlight a row in the Sample Table, then select this command to see the Injection Table (alternatively, click on the Injection Table button on the Toolbar).

TOC Control Software Manual

A typical Injection Table

The Injection Table window is divided into three sections. The table section shows each injection on a separate row. Use the scroll bars at the bottom of the table to view all the information.

Note: The information visible depends on the Display Settings chosen (in the Options menu).

Note: The windows in the Injection Table can be resized by dragging the dividers between the sections.

For information on the Injection Table columns, please see p. 159.

The graph section of the Injection Table is a plot of area counts for each injection. Each data point represents an injection from the table. The graph can show the mean value, plus and minus one and two standard deviations, and can indicate which injections are excluded. To customize the graph display, see Injection Graph, p. 142.

The third section of the Injection Table shows the results of the Outlier Test. The test examines whether any deviations are statistically significant. See p. 147 for more information about this test.

Realtime Window

This command opens the Realtime window, where the current measurement and analysis information is displayed. Alternatively, click the Realtime Window button on the Toolbar to open the window.
In the upper right table, information about each injection is shown once the injection is complete. As the analysis proceeds, the current injection is highlighted in blue. The corresponding Peak Profile for the current injection is shown in the graph on the left. For more information on customizing the graph, see p. 142. Below the graph, the current injection information is shown. On the bottom right, statistical information (the mean area and concentration, standard deviation (SD) and coefficient of variation (CV)) for the injections is calculated and shown. The equations for SD and CV are shown on page 76.

Use the Background Monitor window to monitor the real time signal from the NDIR detector. This window cannot be opened during measurement. At the top of the window, select the range for monitoring. Use the ZOOM IN button to adjust the scale of the graph from ± 100% to ± 5%. The button changes to ZOOM OUT to reduce the magnification.

The Baseline Profile Graph shows a representation of the analog signal from the NDIR. Note that the baseline is drawn from right to left. The graph display can be customized; see Injection Graph, p. 142.

On the right, the actual temperatures of the TC Furnace and the Dehumidifier are shown. The status of the baseline is also evaluated for position, fluctuation, and noise. The baseline position is NG when it deviates more than ± 100% of Full Scale (F.S.) for Range 1, ± 40% F.S. for Range 5, and ± 10% F.S. for Range 30. The baseline fluctuation and noise must be less than 1% F.S. to be OK. When a good baseline cannot be obtained, a zero adjustment of the optical components of the NDIR detector might be necessary. See the instrument manual for a description of this procedure.

Note: Baseline fluctuation is normal while the TC furnace is heating and immediately after a new catalyst or halogen scrubber has been installed.
Message Log

The Message Log window

The Message Log displays warning messages which may appear after the processing of control and track control measurement has taken place. For example, if an "Out of Control Event" occurs in the Control Charts program, this appears in the message log.

Sample Table

Re-opens a Sample Table that was closed when an Injection Table, Peak Profile, Realtime Window, Background Monitor, Message Log, or Statistics (Summary) Table was opened.

Peak Profile

This command opens the Peak Profile window. Select a row in the Sample Table to see the Profile of all the injections in the row. Select a row in the Injection Table to see the Profile for an individual injection. When the Peak Profile/ Display command is chosen, this window is updated each time a new row is selected. When the Peak Profile/ Lock command is chosen, the display is locked for the original Profile selected. The graph can be customized; see p. 142.

This item cannot be selected during measurement.

Method

This command opens the Method File List dialog box.

Either select a previous method, then click OPEN, or select NEW to create a new method. The Method dialog box opens.
**Note:** The Method dialog box is also accessed from the Edit/Insert Sample command, the Edit/Insert Control command, and the Edit/Auto Generate/Edit Method button.

The General tab displays all analysis types. Depending on which analysis type is selected in the Analysis drop down box, other tabs appear behind the General tab, as follows:

<table>
<thead>
<tr>
<th>Analysis Type</th>
<th>Tabs Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC</td>
<td>TC</td>
</tr>
<tr>
<td>IC</td>
<td>IC</td>
</tr>
<tr>
<td>TOC</td>
<td>TC, IC</td>
</tr>
<tr>
<td>NPOC</td>
<td>NPOC</td>
</tr>
<tr>
<td>NPwI</td>
<td>NPOC, IC</td>
</tr>
<tr>
<td>POC*</td>
<td>POC</td>
</tr>
<tr>
<td>POC+NPOC*</td>
<td>POC, NPOC</td>
</tr>
<tr>
<td>POC+NPOC* combined</td>
<td>POC, NPOC</td>
</tr>
<tr>
<td>SSM-TC**</td>
<td>SSM-TC</td>
</tr>
<tr>
<td>SSM-IC**</td>
<td>SSM-IC</td>
</tr>
<tr>
<td>SSM-TOC**</td>
<td>SSM-TC, SSM-IC</td>
</tr>
</tbody>
</table>

* The POC accessory has to be installed and selected in the Options / Instrument Conditions dialog box.
** The Solid Sample Module (SSM) has to be attached to the instrument and selected in the Options / Instrument Conditions dialog box.

**Note:** NPwI is an NPOC analysis with IC check. POC + NPwI is a POC analysis with a following NPOC analysis from the same sample aliquot.

For more information on these analysis types, see p. 4.

**General tab**

**Name**

The Method name appears here. If creating a new method, enter the desired method name. There is no need to enter the .met extension — this will be added by the program.

**Comment**

If desired, a comment can be entered about the method. This item can be selected to appear on a report.

**Sample Name, Sample ID**

Enter a Sample Name and ID if creating a new method. This will be automatically entered into the Sample Table (for Edit/Insert Sample or Edit/Insert Control).

**Analysis**

Select from among TC, IC, TOC, NPOC, NpwI, etc. As described previously, this will affect the number and types of tabs that appear behind the General tab. This selection will also appear in the Sample Table (for Edit/Insert Sample or Edit/Insert Control). For more information on the different types of analysis, see p. 4.

**Type**

Select from among Unknown, Control, and Trk Control. This selection will appear in the sample table (for Edit/Insert Sample).
Detailed Program Description

Note: The selection made here will be superseded by the Edit/Insert Control Sample Type, if a previously created Method is then used for a control.

Dilution

Enter a dilution factor for the sample. The result will be multiplied by this factor for the final concentration calculation. Leave the default value of 1 if there is no dilution.

Revision 23

Select this button when setting up the passing or failing limit according to USP 23 regulations. The Revision 23 dialog box opens.

Verify the USP23 parameter in the Revision 23 dialog box

Verify or change the test parameter. The default parameter is the USP23 method parameter. For more information, see Revision 23 Menu, p. 97 and Insert Control, p. 69.

TC, IC, NPOC tabs (ASI)

Depending upon the Analysis selected in the General tab, one or more analysis tabs appear behind the General tab, where analysis-specific information is entered for the sample. Each tab contains the same information; the TC tab is used below as an example. When making a TOC or NPo1 analysis, ensure that analysis information for both analysis tabs is filled in.

The analysis parameters at the top of the tab contain the values from the Options/Measurement Parameters menu command (see p. 112). If any changes are desired for the sample, enter the changes here; these changes will override (but not change) the Measurement Parameters. These parameters will appear in the Sample Table.

Cal Curves

Specify up to three calibration curves for the sample concentration calculation. Use the BROWSE button to select from the Calibration Curve list (also, a calibration can be edited or created from this box). To see a curve, click in the appropriate line and select Show. This opens the Calibration Curve dialog box (see p. 72).

When the method parameters are to be based on the calibration analysis parameters, select the calibration curve prior to specifying analysis parameters. The method parameters will be changed to match those of the calibration, if desired.
Detailed Program Description

The Calibration Information Verification dialog box

When more than one curve is listed, the program automatically selects the optimal calibration curve for the sample (for ASI analysis). For more information on how this occurs, see Appendix B.

The calibration curve selections appear in the Sample Table (for Edit/Insert Sample and Edit/Insert Control).

If the Method dialog box was accessed from Edit/Insert Sample or Edit/Insert Control, select OK to close the dialog box; save the method when prompted, and the method information is entered into the sample table.

The vial numbers must still be entered into the sample table for samples and controls. Enter the vial number for each sample, then save the sample table.

**Note:** As opposed to the instrument control program, standards and samples can be placed in any ASI tray position with PC Control. Standards do not have to be in the S1-S8 positions.

If the Method dialog box was accessed from the View menu, select OK to close the dialog box, then save any method changes, if desired.

**TC, IC, TOC tabs (SSM)**

When the SSM is in use, three analysis types can be selected from the General tab. As for the ASI, one or more analysis tabs appear behind the General tab, where analysis-specific information is entered for the sample. Each tab contains the same information; the TC tab is shown below as an example. When making a TOC analysis, ensure that analysis information for both analysis tabs is filled in.

TOC Control Software Manual

Enter the information for the SSM sample. First, select whether a solid sample (measured by weight) or a liquid sample (measured by volume) is to be analyzed. Select the appropriate radio button. For liquid samples, enter the density of the liquid.

To use the same conditions as for the calibration, enter or browse for the calibration curve name, then choose Yes in the confirmation dialog box that appears:

Choose Yes to use the same parameters as the calibration

**Statistics (Summary)**

The Statistics Summary command opens the Statistics Table, for examining statistical information for samples from the Sample Table with the same Sample Name. At the top of the table, the Sample Name drop down list shows all Sample Names from the Sample Table. Select one of the Sample Names to display statistical information for all samples with that name.
Detailed Program Description

The Statistic Table window is divided into three sections: the table, graph, and outlier test. The window information can be customized by the Display Options command on the Options menu. Also, the window sections can be resized by dragging the dividers between the sections. To change the column width, hold the mouse over the border on the title cell. The cursor changes to two lines with arrows in the middle. Click, then drag the cell border to the desired width.

To automatically adjust the column width to accommodate the longest entry, double-click when the cursor changes to two lines with arrows.

*Note:* All calculations are performed on the average of the injections. Each row of the table, and each point on the graph, represents the average for the number of injections in that row.

Table

The Table information shows the basic analysis parameters, as well as the average standard deviation (SD), coefficient of variation (CV), area count, concentration, and confidence range. See the Injection Table (p. 137) for more information on the other parameters.

TOC Control Software Manual

Graph

The graph is a plot of concentration for each sample. Plus and minus one and two standard deviations can be shown, as well as the mean. Each data point represents the average of the injections for the sample. Outliers can be displayed differently. The graph can be customized; see Injection Graph, p. 142.

Outlier Test (Grubbs Test)

The results of the statistical test to identify outliers is shown. The results are evaluated to determine whether deviation is statistically significant. For more information on the Grubbs test, see Outlier Test p. 147.

The lower portion of the View menu either shows or hides various tools, status, and shortcut bars. To show the item, select the command. A check mark appears next to the item, indicating that it has been enabled. To deselect the command and hide the item, click on the command again.

Toolbar

This command shows/hides the toolbar, which is the list of shortcut buttons underneath the menu bar.

Common Status bar

This command shows/hides the common status bar, which indicates the status of the analysis, as well as connected component and software information, at the bottom of the window.
Detailed Program Description

Instrument Status bar
This command shows/hides the instrument status bar, which indicates the current status of the various instrument components (TOC, and ASI or SSM), connection information, as well as the general instrument status.

<table>
<thead>
<tr>
<th>Measure</th>
<th>Variety</th>
<th>Mix</th>
<th>ASI</th>
<th>SSM</th>
</tr>
</thead>
</table>

The Instrument Status Bar

See Instrument Status Bar, p. 45, for more information.

Instrument Control bar
This command shows/hides the instrument control bar, which consists of the top half of the Measure menu in button form.

Use the Instrument Control bar or the Measure menu

For more information, see Instrument Control Bar buttons, p. 48.

5. Validation Menu

The Validation menu

Setup Control Samples

The Setup Control Samples dialog box

The Setup Control Samples displays the control sample names and their valid range.

To enter new control samples to the list, select Add to open the Add/Edit Concentration Control Range dialog box, shown below.

The Expected Concentration of Control dialog box

To edit a sample, select a control and then Edit to open the Add/Edit Concentration Control Range dialog box.

To delete a sample, select a control sample, then click Delete. The control is immediately deleted.
Sample Name of Control
Enter the exact name of the sample as it appears in the Sample Table. Note that in the Sample Table, the sample should be specified as a Control in the Type column.

Analysis Type
From the drop down list, select the type of analysis used for the control: TC (total carbon), IC (inorganic carbon), NPOC (non-purgeable organic carbon), POC (purgeable organic carbon), SSM-TC (solid sampling module - TC), SSM-IC (solid sample module - IC).

Valid Range — Low
Enter the lowest valid concentration for the control. If this limit is exceeded, an entry will be recorded in the Message Log.

Valid Range — High
Enter the highest valid concentration for the control. If this limit is exceeded, an entry will be recorded in the Message Log.

Use Area Value for Concentrations
Instead of using concentrations to check control samples, the area count is used.

Setup Control Tracking
Select Setup Control Tracking to open the Control Chart Setup dialog box. This dialog box displays the names of control tracking samples. The results are recorded in the Control Chart software. See p. 169 for more information about this auxiliary program.

To add a new control tracking sample, click Add to open Add/Edit of Control Tracking Samples, described below.

To edit a control tracking sample, select the sample, then click Edit to open Add/Edit of Control Tracking Samples, described next.

Sample Name to Add
In the Sample Name to Add text box, enter the name of the new control tracking sample.

Path/Filename of the Control Chart
Either enter the path and filename of the control chart in the Path/Filename of the Control Chart text box, or select Browse to select the path and filename from the Open dialog box.

Control Chart Type
Select a Control Chart Type using the radio buttons. Select among: Meanvalue, Blindvalue, Spanwidth, and Recovery control chart types. When Recovery is selected, the Recovery Control Chart Options become available.

Recovery Control Chart Options
These options only become available when Recovery Control Chart is selected.
- Certified Standard With Fixed Concentration
- Certified Standard With Variable Concentration
- Real Sample With Fixed Spike Concentration
- Real Sample With Variable Spike Concentration
- Sample Name of Original Sample. This option only becomes available when Real Sample With
Fixed Spike Concentration or Real Sample with Variable Spike Concentration is selected.

Control Charts
Select Control Charts to open the Control Charts application. For more information on this software, see Control Charts, p. 167.

Disable Control Tracking
Select Disable Control Tracking to prevent the results of Controls or Track Controls from being processed by the Control Chart application or evaluated for meeting control limits.

Method Validation
Select Method Validation to open the Method Validation application. See Chapter Eight for more information on Method Validation.

6. Revision 23 Menu

System Suitability Test
The System Suitability Test is described in USP 28. The test involves running a system suitability solution of 500 ppb carbon from 1,4- benzoquinone and comparing it against a calibration curve made from reagent water and 500 ppb C from sucrose.

Calibration Curve
Enter a path and filename for the calibration curve for the system suitability test, or click Browse to select the calibration curve file from the Open dialog box.

Data Area
Once the suitability solution has been measured, the results of the suitability test display in the table. These fields are information fields only and cannot be modified.
7. Measure Menu

Start

Select Start to begin measurement.

When using the ASI analysis will proceed in order according to the Sample Table.

If a Sample Table already containing data is started, the Start Measurement dialog box appears, to prevent data from being accidentally overwritten.

Choose CANCEL to cancel the measurement without overwriting data. Choose APPEND to continue a Sample Table which was previously interrupted. Select OVERWRITE to execute the Sample Table, replacing any previously acquired data.

When making analyses without the ASI, the following dialog box appears after the Start button is pressed.

Choose the desired measurement mode. Normal measurement means that, for TOC analyses, the TC portion of the analysis will be conducted, then the instrument will wait for a prompt from the user before conducting the IC analysis. In Non Stop mode, the TC analysis and the IC analysis will be conducted, then the instrument will stop, waiting for the user to prompt it to continue. In Continuous mode, the Sample Table will be executed continuously until the user stops the measurement.

Without the ASI, measurement of the first sample will occur according to the Measurement mode. The Measurement Completed dialog box opens after the analysis of the first sample is complete (unless Continuous mode was selected).

The sample information and statistical results are shown. If the analysis was not satisfactory, choose REPEAT to re-analyze the sample. Otherwise, select CONTINUE to proceed to the next sample. Choose CANCEL to stop the measurement.
Detailed Program Description

Stop
Stops instrument operations after completing the current measurement.

Halt
Completes the current rinse or injection, then stops instrument operation.

Pause
Immediately stops the current operation. Press Continue to resume operations.

Continue
After an instrument has been paused, Continue becomes available. Select Continue to resume operations at the point they were paused.

Connect
Select Connect to connect to the instrument. A dialog box opens, displaying connection status. The following messages may appear in that dialog box:
Open Comm indicates that the serial interface is open.
TOC Initialize initializes the instrument.
TOC Mechanical initialize initializes the mechanical part of the instrument according to the instrument conditions.

Standby
Select Standby to open the Standby dialog box.

TOC Control Software Manual

Shutdown Instrument
Select Shutdown Instrument to begin a thirty minute countdown to instrument shutdown. During shut down, the carrier gas is turned off and the furnace cools down. When the countdown is finished, the instrument is safe to turn off. Click OK several times to see the countdown counter.

Caution: Do not turn off the main instrument switch for at least 30 minutes.

Auto Restart
Select Auto Restart to start the instrument at a specified time.

Keep TC Furnace Heating
Select Keep TC Furnace Heating to keep the TC Furnace On while the instrument is on Standby.

Keep Carrier Gas Flowing
Select Keep Carrier Gas Flowing to keep the carrier gas flowing while the instrument is on Standby.

Auto Start Time
Use the Year, Month, Day, Hour, and Minute fields to enter a time for the instrument to restart. The furnace turns on one hour before the auto-start time.
8. Report Menu

The Run Time Report menu items are used to print reports automatically during measurement using the specified report contents.

Run Time Report
Select this item to enable Run Time Report generation. A check mark appears next to the command, indicating that Run Time Reports will be printed during measurement. Select the command again to disable the Run Time Report feature. This command can also be selected and deselected with the RTR toolbar button.

Start New RTR Page
The current Run Time Report page is printed, even if the page is not yet completely filled. The next measurement starts on a new Run Time Report page.

Quick Report
Select this command to immediately print a Quick Report. This report consists of all standards and samples in the Sample Table, and includes basic information for the analysis and each measurement.
Run Time Report Configuration

Select the items to be included on the Run Time Report. The information comes from the Options/General Information dialog box, Sample Table and Injection Table. Note that the options in the injections section vary with the components selected (ASI or SSM) in the Instrument Conditions dialog box (see p. 105)

Click on the Default button for typical report selections, or Select All to print all items. Clear the selections with the Select None button.

9. Options Menu

General Information

Select General Information to open the General dialog box. The information in this dialog box is included in the TOC Control report. In the corresponding text boxes, enter a User, Title, and Comment. The Organization and Instrument ID fields contain the information entered at installation.

Instrument Conditions

Select Instrument Conditions to open the Instrument Conditions dialog box. In this dialog box, select the desired features, described in detail here. Refer to Principles of TOC Operation, p. 4, for more information on choosing TOC conditions.
POC Option
Specify whether the POC accessory is present.

Sparge Gas Flow
Select *Sparge Gas Flow* to turn on the sparge gas flow, for adjusting the flow rate and testing the flow.

Auto Ranging and Injection Volume
Select auto ranging to change the range setting (×1, ×5, or ×30) automatically if the initial setting is incorrect. If the first sample injection peak height exceeds the full scale, the range will be changed automatically to accommodate that of a higher concentration and measurement conducted again.

When the peak height exceeds the full scale even at the maximum ×30 range, the initial injection volume setting is automatically changed by a factor of 50%, 40%, or 20%. Injection values will be rounded to the nearest integer.

Auto Regenerating of IC Solution
IC solution in the IC reaction vessel, which is acidified with IC reagent, converts IC components in the sample into CO₂. The acid concentration in the IC solution gradually decreases due to reaction with IC and dilution by the injected sample, eventually losing its ability to fully convert the IC into CO₂.

Select *Auto Regenerating of IC Solution* to maintain the appropriate pH and level of the IC reaction solution. The instrument automatically pumps IC reagent from the IC reagent reservoir to the reaction vessel in the following cases:
- When the instrument is turned ON
- Prior to the initial IC measurement, following a preset number of injections and preset volume of injected samples
- If peak tailing occurs in IC measurement (T” is indicated in the Notes column of the Injections table or Remark column in the Sample table)
Enable Ready State Checking

When this item is selected, the instrument will proceed to the next injection without checking whether the instrument status is "Ready." Normally, do not select this item (the default is "not selected").

\* Note: In this software version, the box is labeled incorrectly. To use the Ready State checking function, (i.e., the instrument will not proceed to the next injection until it is Ready), leave the box UNCHECKED.

Syringe Injection Speed

The Syringe Injection Speed should be changed depending on the diameter of the sample and injection tubing. Select the appropriate particle size from this drop-down list. The 0.5 and 0.8 mm sizes must be used with the correct suspended particle (SP) kit (Part No. 638-90345-xx).

Syringe Size

From the drop down list, select the syringe size for the syringe installed on the syringe pump. Choose from: 250, 500, 1000, or 2500 µL.

Syringe Wash

Choose the amount of sample to draw for a sample wash between each injection. Choose from STD (the amount is equal to size of the installed syringe), 100 µL, 50 µL, or 0 µL.

ASI Used

Select ASI Used if using an autosampler. You cannot use an ASI and a SSM at the same time. Selecting this option changes the columns available in the Sample Table, Injection Table, and Statistics Table, so that ASI parameters become visible.

High Sensitivity Vials

Two types of vials are used for samples in the ASI. A smaller size is used for regular sensitivity analysis and a larger size is used for high sensitivity analysis. The vial capacities are shown below.

<table>
<thead>
<tr>
<th>Vial</th>
<th>Total capacity</th>
<th>Normal analysis capacity</th>
<th>NPOC high sensitivity analysis capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large vial</td>
<td>53.5 ml</td>
<td>~42 ml*</td>
<td>~31 ml†</td>
</tr>
<tr>
<td>Small vial</td>
<td>6.5 ml</td>
<td>~4.5 ml*</td>
<td></td>
</tr>
</tbody>
</table>

* Capacity with vial filled to within 5 mm of the top
† To avoid splashing of sample on inside of vial cap during sparging (in NPOC), the vial is only filled to within 20 mm of the top.

When using high sensitivity vials, select High Sensitivity Vials.
Detailed Program Description

Rinse
Select this item to enable rinsing of the needle, syringe, and flow lines with TOC grade water from the ASI reservoir. This rinse will be performed between each sample.

No. of Needle Washes
Enter the number of times (0 – 3) the outside of the needle is to be cleaned with TOC grade water from the ASI reservoir at the end of a sample run.

No. of Flow Line Washes
Enter the number of times (0 – 4) the full syringe volume is used to rinse the flow lines with TOC grade water from the rinse container at the end of the Sample Table run.

Rinse After Acid Addition
Select this item to enable rinsing of the syringe and flow lines (with TOC grade water from the ASI reservoir) after acid addition.

SSM tab

The SSM tab

SSM Used
Check SSM Used if using a Solid Sampling Module. You cannot use an ASI and a SSM at the same time. Selecting this option changes the columns available in the Sample Table, Injection Table, and Statistics Table, so that SSM parameters become visible.

TOC Control Software Manual

SSM TC Furnace On
Select SSM TC Furnace On if using a Total Carbon furnace with the SSM.

SSM IC Furnace On
Select SSM IC Furnace On if using an Inorganic Carbon furnace with the SSM.

Cell Length
Select the W-Long or W-Short cell. Use the long cell to measure liquid samples when using the tandem cell.

RS232 tab

If a Shimadzu representative installed the software, the correct settings for your system are already configured. Do not change them.

COM Port
From the COM Port drop down list, select the COM port to which the communications cable is attached.

Parity
Select None or Even for the parity. None is generally used.

Baud Rate
Select the baud rate for communications. This setting is normally set to 2400 bps.
Detailed Program Description

Stop Bits
Choose 1 or 2 stop bits. 1 is generally used.

Measurement Parameters

In the Measurement Parameters dialog box, select measurement parameters to be used when developing a new method or calibration (note that the default values cannot be changed; these must be specified before each new method or calibration is created). A new method is created in the Method dialog box, accessed by selecting View/Method. A new calibration is created by selecting View/Calibration Curve File List.

Measurement Parameters dialog box

Unit
Enter the default units used for measuring concentration. Select from: ppm, ppb, mg/l, %, and no unit.

No. of Injections
Enter the number of injections per sample.

Max. No. of Inj.
Specify the maximum number of injections per sample.

No. of Washes
Enter the number of times the syringe will be rinsed with sample.

Sparge Time
Enter the amount of time that sparging will occur (when sparging is conducted).

Max SD
Define the standard deviation (SD) limit. If the SD exceeds this limit, the sample will be re-injected the number of times specified in the Max No. of Inj., or until it is below the limit.

Max CV
Define the coefficient of variation (CV) limit. If the CV exceeds this limit, the sample will be re-injected the number of times specified in the Max. No. of Inj., or until it is below the limit.

Display Settings

Display Settings dialog box

In the Display Settings dialog box, specify the items that appear in the Sample, Injection, and Statistics Tables. These settings allow you to customize the appearance of these tables; data that is not displayed is not lost. Note that the options available vary with the components selected (ASI, SSM) in the Instrument Conditions dialog box (see p. 105)

The dialog box consists of three tabs.